


Word Tutorial 2: Editing and Formatting a Document  

 
TRUE/FALSE 

 

 1. In Word, click the Show/Hide button to display nonprinting characters.  

 

ANS: T PTS: 1 REF: WD 47 

 

 2. Word does not have default setting for font or paragraph settings, so you need to select these upon opening a document. 

 

ANS: F PTS: 1 REF: WD 47 

 

 3. You can save time using the Spelling and Grammar checker since you do not need to proofread your document.  

 

ANS: F PTS: 1 REF: WD 52 

 

 4. One of the most useful features of a word-processing program is the ability to move text. 

 

ANS: T PTS: 1 REF: WD 54 

 

 5. When using drag and drop, the dotted insertion point will let you determine exactly where the text will be inserted.  

 

ANS: T PTS: 1 REF: WD 54 

 

 6. Positioning the pointer over text you have selected to move, the pointer changes from a left-facing arrow to a right-facing arrow. 

 

ANS: F PTS: 1 REF: WD 55 

 

 7. When you paste an item from the Clipboard into a document, the item remains on the Clipboard so you can paste it again somewhere else if you 

want. 

 

ANS: T PTS: 1 REF: WD 57 

 

 8. When the Clipboard task pane is not displayed, the Clipboard can hold only one item at a time.  

 

ANS: T PTS: 1 REF: WD 57 

 

 9. In Word, you can search for formatting, such as bold or italics, using the Find and Replace dialog box.  

 

ANS: T PTS: 1 REF: WD 64 

 

 10. If you zoom in to make the text larger and easier to read, you see more of the margin.  

 

ANS: F PTS: 1 REF: WD 65 

 

 11. The Paragraph group on the Home tab includes a button for each of the four major types of alignment.  

 

ANS: T PTS: 1 REF: WD 69 

 

 12. To align a single paragraph, click anywhere in that paragraph and then click the appropriate alignment button.  

 

ANS: T PTS: 1 REF: WD 69 



 

 13. The buttons used to increase or decrease indentions are located on the Home tab.  

 

ANS: T PTS: 1 REF: WD 71 

 

 14. When you double-click the Format Painter button, it stays selected until you click it again.  

 

ANS: T PTS: 1 REF: WD 73 

 

 15. If you click the Format Painter once, the formatting of the paragraph will change to match the paragraph from which you copied formatting.  

 

ANS: F PTS: 1 REF: WD 74 

 

 16. Bulleted lists are usually much easier to read and follow than lists that do not have bullets. 

 

ANS: T PTS: 1 REF: WD 74 

 

 17. You can use squares, circles, or check marks to denote different items in a bulleted list.  

 

ANS: T PTS: 1 REF: WD 75 

 

 18. When using a Numbered list, if you delete a line item, you need to renumber the items.  

 

ANS: F PTS: 1 REF: WD 76 

 

 19. Keyboard shortcuts usually take longer than performing commands by clicking buttons with the mouse.  

 

ANS: F PTS: 1 REF: WD 79 

 

 20. KeyTips are time saving ways to select buttons and keys.  

 

ANS: T PTS: 1 REF: WD 80 

 
MODIFIED TRUE/FALSE 

 

 1. To hide the blue space between pages, right-click the blue space. ____________________ 

 

ANS: F 

double-click 

double click 

 

PTS: 1 REF: WD 47 

 

 2. Word marks possible spelling errors with a green wavy underline. ____________________ 

 

ANS: F, red 

 

PTS: 1 REF: WD 50 

 

 3. To add an unrecognized word to the dictionary, click the Add to Dictionary button. ____________________ 

 

ANS: T   PTS: 1 REF: WD 50 

 



 4. To check spelling errors only, check the Check grammar check box. ____________________ 

 

ANS: F 

deselect 

do not select 

don’t select 

uncheck  

un check 

do not check 

don’t check 

 

PTS: 1 REF: WD 51 

 

 5. If you don’t want to remove the text from its original location, you can copy it. ____________________ 

 

ANS: T   PTS: 1 REF: WD 57 

 

 6. The Clipboard task pane is a special part of the Word window that displays the contents of the clipboard. ____________________  

 

ANS: T   PTS: 1 REF: WD 57 

 

 7. The Clipboard can hold a total of 50 items. ____________________ 

 

ANS: F 

24 

twenty-four 

twenty four 

 

PTS: 1 REF: WD 57 

 

 8. Replace is used to find a word or phrase in a document and replace it with something else. ____________________  

 

ANS: T   PTS: 1 REF: WD 61 

 

 9. By default, the margins for a Word document are one-half inch on the top, bottom, and sides. ____________________ 

 

ANS: F 

one inch 

1”  

1 inch 

 

PTS: 1 REF: WD 64 

 

 10. In the Page Layout tab, you can choose from a group of predefined margin settings. ____________________  

 

ANS: T   PTS: 1 REF: WD 65 

 

 11. The Modified toolbar appears when you select text in a document, showing commonly used formatting buttons.  

 

ANS: F, Mini 

 

PTS: 1 REF: WD 69 

 

 12. The style currently applied to a numbered list is highlighted in orange. ____________________ 



 

ANS: T   PTS: 1 REF: WD 76 

 

 13. You can save time by using KeyTips, sometimes called access keys. ____________________ 

 

ANS: T   PTS: 1 REF: WD 80 

 

 14. To hide KeyTips without using them, press the Delete key. ____________________ 

 

ANS: F 

Esc 

Escape 

 

PTS: 1 REF: WD 80 

 

 15. Twenty different themes are included in Word, with each offering a coordinated assortment of fonts, colors, and visual effects. 

____________________ 

 

ANS: T   PTS: 1 REF: WD 80 

 
MATCHING 

 

Match the following shortcut keys with their functions. 

a. Ctrl + B g. Ctrl + X 

b. Ctrl + I h. Ctrl + C 

c. Ctrl + U i. Ctrl + V 

d. Ctrl + 1 j. Ctrl + Z 

e. Ctrl + 2 k. Ctrl + Home 

f. Ctrl + A l. Ctrl + End 
 

 

 1. Keyboard shortcut used to format underlined text 

 

 2. Shortcut to cut text 

 

 3. Would result in making highlight text boldface 

 

 4. Pastes most recently copied item at location of insertion point  

 

 5. Single-spaces lines within paragraph that currently contain insertion point  

 

 6. Moves the insertion point to the beginning of the document  

 

 7. Keyboard shortcut for italicizing text 

 

 8. Use to undo your most recent action 

 

 9. Copies selected text to Clipboard 

 

 10. Double-spaces lines within paragraph that currently contain insertion point 

 

 11. Selects the entire document  

 

 12. Moves the insertion point to the end of the document  

 

 1. ANS: C PTS: 1 REF: WD 80 

 

 2. ANS: G PTS: 1 REF: WD 80 

 

 3. ANS: A PTS: 1 REF: WD 79 

 

 4. ANS: I PTS: 1 REF: WD 80 

 

 5. ANS: D PTS: 1 REF: WD 80 

 

 6. ANS: K PTS: 1 REF: WD 83 

 

 7. ANS: B PTS: 1 REF: WD 79 

 

 8. ANS: J PTS: 1 REF: WD 80 

 

 9. ANS: H PTS: 1 REF: WD 80 



 

 10. ANS: E PTS: 1 REF: WD 80 

 

 11. ANS: F PTS: 1 REF: WD 80 

 

 12. ANS: L PTS: 1 REF: WD 52 

 
MULTIPLE CHOICE 

 

 1. In the Open dialog box, use the Look in arrow to ____. 

a. navigate to a document c. search for text 

b. save a document d. convert a file 
 

 

ANS: A PTS: 1 REF: WD 46 

 

 2. When working in Word 2007, files will be saved with a ____ extension. 

a. .pptx c. .docs 

b. .xlsx d. .docx 
 

 

ANS: D PTS: 1 REF: WD 46 

 

 3. If rulers are not visible, click the Ruler check box on the ____ tab. 

a. Home c. Display 

b. Preview d. View 
 

 

ANS: D PTS: 1 REF: WD 47 

 

 

 

 4. In the figure above, Item ____ indicates the font size used for the document. 

a. 1 c. 5 

b. 2 d. 8 
 

 

ANS: A PTS: 1 REF: WD 47 

 

 5. Item 2 in the figure above indicates that Calibri has been chosen for the document’s ____. 



a. format c. font 

b. font size d. spacing 
 

 

ANS: C PTS: 1 REF: WD 47 

 

 6. To determine the zoom setting, you would look to Item ____ in the above figure.  

a. 1 c. 5 

b. 2 d. 8 
 

 

ANS: D PTS: 1 REF: WD 47 

 

 7. The total number of pages in the document is indicated by Item ____ in the above figure. 

a. 1 c. 5 

b. 3 d. 8 
 

 

ANS: C PTS: 1 REF: WD 47 

 

 8. In the figure above, Item ____ is an example of a list. 

a. 3 c. 6 

b. 4 d. 7 
 

 

ANS: A PTS: 1 REF: WD 47 

 

 9. The blue space indicated by Item 7 in the above figure ____. 

a. indicates a space between pages c. indicates a formatting error 

b. is a formatting break d. indicates a separate document 
 

 

ANS: A PTS: 1 REF: WD 47 

 

 10. The ____ checks a document word by word for a variety of errors. 

a. Review marker c. Format tool 

b. Spelling and Grammar checker d. Reference checker 
 

 

ANS: B PTS: 1 REF: WD 50 

 

 11. Choosing ____ will skip a currently flagged spelling error but recognize all future instances. 

a. Change c. Ignore Once 

b. Skip d. Ignore All 
 

 

ANS: C PTS: 1 REF: WD 50 

 

 12. The Spelling and Grammar button is located in the ____ group. 

a. Proofing c. Format 

b. References d. Page Layout 
 

 

ANS: A PTS: 1 REF: WD 50 

 

 13. While using the Spelling and Grammar checker, if you type a change directly in a document, click ____ to continue the check. 

a. Contine c. Check More 

b. Resume d. Return to Check 
 

 

ANS: B PTS: 1 REF: WD 50 

 

 14. Proofing tools are located in Word’s ____ tab on the Ribbon. 

a. Review c. Home 

b. Insert d. View 
 

 



ANS: A PTS: 1 REF: WD 50 

 

 15. To ensure that Word checks your entire document for errors, it is good practice to ____ before using Spelling and Grammar Checker. 

a. close the document 

b. click the Home tab 

c. move the insertion point to the beginning of the document 

d. move the insertion point to the end of the document 
 

 

ANS: C PTS: 1 REF: WD 50 

 

 16. Even though the Spelling and Grammar Checker is a useful tool, you should ____. 

a. proofread your document for inaccurate phrases 

b. run the Checker more than once 

c. not trust any of the grammar suggestions 

d. not use it to review your document 
 

 

ANS: A PTS: 1 REF: WD 52 

 

 17. To avoid losing any changes you make to a document, click ____ on the Quick Access Toolbar. 

a. Save c. Copy 

b. Paste d. Print 
 

 

ANS: A PTS: 1 REF: WD 52 

 

 18. If you press the ____ keys, the insertion point moves to the end of the document. 

a. Ctrl+Home c. Shift+Home 

b. Ctrl+End d. Shift+End 
 

 

ANS: B PTS: 1 REF: WD 52 

 

 19. To select two single words on two separate lines, you can double-click the first word, press and hold the ____ key, and double-click the second 

word. 

a. Shift c. Enter 

b. Ctrl d. Tab 
 

 

ANS: B PTS: 1 REF: WD 53 

 

 20. If the words “jury” and “rest” are both highlighted, you can ____. 

a. press Delete to remove both words c. change the font size of both words 

b. click i on the toolbar to format both words 

in italics 

d. all of the above 

 

 

ANS: D PTS: 1 REF: WD 53 

 

 21. Word allows you to move text ____. 

a. with drag and drop c. by copying and pasting 

b. by cutting and pasting d. all of the above 
 

 

ANS: D PTS: 1 REF: WD 54 

 

 22. When you move the pointer over the selection bar, it changes to a ____. 

a. cross-hair arrow c. left-facing arrow 

b. right-facing arrow d. cross bar 
 

 

ANS: B PTS: 1 REF: WD 54 

 



 23. When formatting text in Word, you might use the Undo function if ____. 

a. you moved text to the wrong location 

b. you deleted the wrong paragraph 

c. you changed the font to Arial and want to change it back to Calibri 

d. you did any of the above 
 

 

ANS: D PTS: 1 REF: WD 56 

 

 24. You typed a paragraph on page 2 that should appear on page 7. To move that paragraph to the correct place in your document, you should use 

____. 

a. Drag and Drop c. Delete and Replace 

b. Cut and Paste d. Copy and Paste 
 

 

ANS: B PTS: 1 REF: WD 57 

 

 25. To use Cut and Paste, click the Cut button from the ____ group on the Home tab. 

a. Styles c. Paragraph 

b. Clipboard d. Editing 
 

 

ANS: B PTS: 1 REF: WD 58 

 

 26. Click the ____ in the Clipboard group to open the Clipboard task pane. 

a. Dialog Box Launcher c. Format Painter 

b. Home tab  d. View All 
 

 

ANS: A PTS: 1 REF: WD 59 

 

 27. To have the Clipboard task pane open each time you cut or copy an item, click ____ at the bottom of the Clipboard task pane. 

a. Open  c. Options 

b. Always Open d. Select 
 

 

ANS: C PTS: 1 REF: WD 59 

 

 28. Clicking the ____ button on the Clipboard task pane will delete the contents of the Clipboard. 

a. Delete All c. Erase  

b. Clear All d. Collapse 
 

 

ANS: B PTS: 1 REF: WD 61 

 

 29. To move the cursor directly to a specific part of a document, use the ____ button. 

a. Go To c. Find 

b. Replace d. Search 
 

 

ANS: A PTS: 1 REF: WD 61 

 

 30. In the Find and Replace dialog box, click ____ to display options such as ‘Find whole words’. 

a. All c. More 

b. Down d. Less 
 

 

ANS: C PTS: 1 REF: WD 62 

 

 31. While writing a report, you decide that you want to find all the times you have referenced your last name using Find. If you’re at the bottom of 

page 3, make sure to choose ____ to find all instances through the current page. 

a. Down c. All  

b. Up d. More 
 

 

ANS: B PTS: 1 REF: WD 62 



 

 

 

 32. If you wanted to enter search text, you would position the insertion point at the arrow marked by Item ____ in the above figure. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: A PTS: 1 REF: WD 63 

 

 33. To replace text with a new word or phrase, use the line indicated by Item ____. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: C PTS: 1 REF: WD 63 

 

 34. In the figure above, using Item ____ ensures that only “PFI” and not “pfi” will be replaced. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: B PTS: 1 REF: WD 63 

 

 35. To change every instance of a word or phrase in a document, click ____ in the figure above. 

a. Item 1 c. Item 3  

b. Item 2 d. Item 4 
 

 

ANS: D PTS: 1 REF: WD 63 

 

 36. In Word, you can change margins ____. 

a. in the Page Setup dialog box c. in the Review tab 

b. in Print Layout View d. both a and b 
 

 

ANS: D PTS: 1 REF: WD 65 

 



 

 

 37. To have new margin settings apply only from this point forward, adjust the settings in Item ____. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: D PTS: 1 REF: WD 67 

 

 38. The ____ tab is selected in the above figure. 

a. Paper c. Margins 

b. Layout d. Page Setup 
 

 

ANS: C PTS: 1 REF: WD 67 

 

 39. Item 2 in the above figure indicates that the ____ is selected. 

a. Top margin c. Left margin 

b. Bottom margin d. Right margin 
 

 

ANS: A PTS: 1 REF: WD 67 

 

 40. To preview changes as you adjust the margins, look to the area indicated by Item ____. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: C PTS: 1 REF: WD 67 

 

 41. In the figure above, ____ orientation is selected. 

a. Portrait c. Page 

b. Landscape d. Preview 
 

 

ANS: A PTS: 1 REF: WD 67 

 

 42. With ____, full lines of text are spaced between both the left and the right margins, and the text is not ragged. 

a. left alignment c. center alignment 



b. right alignment d. justified alignment 
 

 

ANS: D PTS: 1 REF: WD 69 

 

 43. The Mini toolbar includes the ____ button. 

a. Center c. Left align 

b. Right align d. both b and c 
 

 

ANS: A PTS: 1 REF: WD 69 

 

 44. To see a paragraph’s current indent settings, look at the ____ on the horizontal ruler. 

a. indent markers c. alignment settings 

b. right tabs d. formatting 
 

 

ANS: A PTS: 1 REF: WD 71 

 

 45. The indent buttons on the Home tab allow you to increase or decrease paragraph indenting in increments of ____. 

a. 0.1 c. 1.0 

b. 0.5 d. 1.5 
 

 

ANS: B PTS: 1 REF: WD 71 

 

 46. With a ____ indent, all lines except the first line of the paragraph are indented from the left margin. 

a. left c. center 

b. right d. hanging 
 

 

ANS: D PTS: 1 REF: WD 71 

 

 

 

 47. To move a paragraph to the left, you would click the button indicated by Item ____ in the above figure. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: A PTS: 1 REF: WD 72 

 

 48. Item 3 in the above figure indicates the ____. 

a. document height c. left margin 

b. document width d. right margin 
 

 

ANS: C PTS: 1 REF: WD 72 

 



 49. Item ____ in the above figures indicates an indented paragraph. 

a. 2 c. 4 

b. 3 d. 5 
 

 

ANS: D PTS: 1 REF: WD 72 

 

 50. Indent markers are show by Item ____ in the above figure. 

a. 1 c. 3 

b. 2 d. 4 
 

 

ANS: D PTS: 1 REF: WD 72 

 

 51. Clicking the button indicated by Item 2 in the above figure would ____. 

a. move the paragraph to the left c. move the document to the right 

b. move the paragraph to the right d. move the document to the left 
 

 

ANS: B PTS: 1 REF: WD 72 

 

 52. When using the Format Painter, the pointer changes to a(n) ____ to indicate a paragraph format is ready to be copied, or “painted”. 

a. paintbrush c. cross hair arrow 

b. paint can d. paragraph marker 
 

 

ANS: A PTS: 1 REF: WD 73 

 

 53. To access square bullets, click the ____ to access the full gallery of bullet styles. 

a. Bullet button arrow c. Show all tab 

b. Bullet dropdown menu d. Options box 
 

 

ANS: A PTS: 1 REF: WD 74 

 

 54. The Bullets button is located in the ____ group. 

a. Styles c. Paragraph 

b. Font d. Format 
 

 

ANS: C PTS: 1 REF: WD 74 

 

 55. To see a ____ of numbering formats, move the mouse pointer over the options in the Numbering library. 

a. sneak peak c. prototype 

b. live preview d. formatting plan 
 

 

ANS: B PTS: 1 REF: WD 76 

 

 56. To format a list in sequential order, you should use a(n) _____. 

a. bulleted list c. numbered list 

b. check list d. arrow list 
 

 

ANS: C PTS: 1 REF: WD 76 

 

 57. All of the following are part of the four basic document styles except ____. 

a. Formal c. Eclectic 

b. Traditional d. Calligraphic  
 

 

ANS: D PTS: 1 REF: WD 76 

 

 58. All of the following are options for numbering from the Numbering library except ____. 

a. A, B, C,... c. #1, #2, #3,... 

b. i., ii., iii., ... d. 1), 2), 3),... 
 



 

ANS: C PTS: 1 REF: WD 77 

 

 59. In the Font group, I denotes ____ formatting. 

a. bold c. italics 

b. underlined d. no 
 

 

ANS: C PTS: 1 REF: WD 79 

 

 60. To keep one paragraph with another, change the settings in the ____ tab. 

a. Font c. Section Breaks 

b. Line and Page Breaks d. Paragraph Formatting 
 

 

ANS: B PTS: 1 REF: WD 79 

 

 61. The document ____ controls the variety of fonts, colors, and other visual effects available for formatting a document. 

a. style c. theme 

b. layout d. size 
 

 

ANS: C PTS: 1 REF: WD 80 

 

 62. To use KeyTips, press the ____ key and notice the letters displayed over each tab.  Press the letter for the tab that contains the feature you 

want. 

a. Ctrl c. Alt 

b. Fn d. Windows 
 

 

ANS: C PTS: 1 REF: WD 80 

 

 63. To create a harmonious-looking document, it is important to use no more than ____ fonts. 

a. 1 c. 3 

b. 2 d. 5 
 

 

ANS: B PTS: 1 REF: WD 80 

 

 64. In the Office theme, the heading font is ____ and the body font is ____. 

a. Cambria, Calibri c. Calibri, Times New Roman 

b. Helvetica, Arial d. Cambria, Verdana 
 

 

ANS: A PTS: 1 REF: WD 80 

 

 65. The heading and body font for a document theme are listed ____. 

a. at the top of the font list c. in the document 

b. at the bottom of the font list d. in a dialog box 
 

 

ANS: A PTS: 1 REF: WD 80 

 

 66. If you click the Font arrow, the order of font listings is ____. 

a. Theme Fonts, Recently Used Fonts, All Fonts 

b. Theme Fonts, All Fonts, Recently Used Fonts 

c. Theme Fonts, All Fonts, Recently Used Fonts 

d. Recently Used Fonts, Theme Fonts, All Fonts 
 

 

ANS: A PTS: 1 REF: WD 81 

 

 67. The font and font size settings in the Font group reflect the settings of the ____. 

a. entire document 

b. header and footer 



c. body of the document 

d. text currently containing the insertion point 
 

 

ANS: D PTS: 1 REF: WD 82 

 

 68. If you know you will usually need a particular margin, click the ____ button on the Margins tab. 

a. Format c. Default 

b. Indent d. Apply to 
 

 

ANS: C PTS: 1 REF: WD 68 

 

 69. The Mini toolbar contains the button used to ____. 

a. change the font c. highlight text 

b. change font size d. all of the above 
 

 

ANS: D PTS: 1 REF: WD 70 

 

 70. To quickly open a document you were recently working on in Word, click the Office button and choose the document from the ____ list. 

a. Recently Used c. All Documents 

b. Recent Documents d. New Documents 
 

 

ANS: B PTS: 1 REF: WD 84 

 

Case-Based Critical Thinking Questions 

 

Case 1 

James is writing a report for his advertising class to analyze corporate campaigns and ad slogans. To compile his report, he needs to copy 

several quotes and portions of articles from other documents, and needs to pay special attention to formatting.  

 

 71. Word flagged “Just do it!” as a grammatical error, but James’s report includes several instances of this slogan. How can he avoid having to 

ignore each instance? 

a. Ignore Once c. Ignore All 

b. Ignore Grammar d. Skip All 
 

 

ANS: C PTS: 1 REF: WD 50 TOP: Critical Thinking 

 

 72. James needs to copy quotes from several of his research documents. To keep track of what text he has copied, James should ____. 

a. open the Clipboard task pane 

b. paste all the text in a separate Word document so he can view it 

c. Neither of the above; copied text is automatically erased when new text is copied 

d. There is no way to track what he’s copied 
 

 

ANS: A PTS: 1 REF: WD 57 TOP: Critical Thinking 

 

 73. James has typed 20 pages of his report and realizes that he typed Niko and should have typed Nike.  The most efficient way for his to fix this 

error is to ____. 

a. proofread c. run the Spelling and Grammar Checker 

b. use Find and Replace d. search the text 
 

 

ANS: B PTS: 1 REF: WD 61 TOP: Critical Thinking 

 

 74. James is reviewing all his documents and decides that using boldface and italics is too heavy. To change the formatting, he should use ____. 

a. Find and Replace c. Search for  

b. Headers d. Delete 
 

 

ANS: A PTS: 1 REF: WD 64 TOP: Critical Thinking 



 

 75. James needs to use the formatting of his first header in all other headers in his report. To save time, you suggest that he use ____. 

a. copy and paste c. the Zoom feature 

b. the Format Painter d. manual formatting 
 

 

ANS: B PTS: 1 REF: WD 72 TOP: Critical Thinking 

 

Case-Based Critical Thinking Questions 

 

Case 2 

Claire has just taken a job at a local publishing house. She has a lot of tasks to accomplish today, but her first task is to write letters to several of 

the authors and send out contracts. Claire wants to make a good impression on her boss, so she wants to make sure all her correspondence with 

the authors is professional and looks formal. 

 

 76. Claire is printing several copies of her letter on company letterhead, but her text is running on top of the letterhead logo when she prints. She 

should ____. 

a. print on longer paper 

b. use different paper, because Word does not allow you to print on letterhead. 

c. adjust the top margin 

d. adjust the page width 
 

 

ANS: C PTS: 1 REF: WD 65 TOP: Critical Thinking 

 

 77. Claire knows that she will be drafting several contracts in the coming weeks, and each letter will need to be printed with a cover sheet on the 

letterhead. To save time, Claire should ____. 

a. adjust the header each time she wants to print 

b. set Default margins to change the settings for her letterhead  

c. use the copy machine to correctly orient the cover sheets on letterhead 

d. copy and paste the format of each cover sheet to a new document 
 

 

ANS: B PTS: 1 REF: WD 68 TOP: Critical Thinking 

 

 78. In her letter, Claire asks each author to return a copy of their signed agreement. She needs to remain professional in her letter, but she wants to 

make sure everyone reads this sentence. She should ____. 

a. make the font twice as large c. emphasize the text with bold or italic 

b. format the text in bright red d. put the text in a different font 
 

 

ANS: C PTS: 1 REF: WD 78 TOP: Critical Thinking 

 

 79. Claire is still having problems formatting her document to print correctly on the company letterhead. After looking at Print Preview, she thinks 

it would help to move all text in her document to the right by one inch. How? 

a. Change the right margins c. Use the left indent 

b. Set the hanging indent d. None of the above 
 

 

ANS: C PTS: 1 REF: WD 71 TOP: Critical Thinking 

 

 80. Claire notices a green wavy underline in part of her document where she accidentally typed “I is” rather than “I am”.  This is because ____. 

a. Word found a spelling error c. Word marks all instances of “I” 

b. Word has marked a grammar error d. Claire has underlined the phrase 
 

 

ANS: B PTS: 1 REF: WD 50 TOP: Critical Thinking 

 
COMPLETION 

 

 1. To display the full width of a document in Word, click ____________________. 



 

ANS: Page width 

 

PTS: 1 REF: WD 47 

 

 2. If you highlight a word or phrase to format it, then realize that you highlighted the wrong text, you can ____________________ anywhere in 

the document to remove the highlighting from the text. 

 

ANS: click 

 

PTS: 1 REF: WD 53 

 

 3. If you delete the wrong text, click the ____________________ button on the Quick Access Toolbar to reverse your mistake.  

 

ANS: Undo 

 

PTS: 1 REF: WD 54 

 

 4. To move text with ____________________, select the text you want to move, press and hold down the mouse button, and drag the text to a 

new location. 

 

ANS:  

drag and drop 

drag-and-drop 

drag & drop 

 

PTS: 1 REF: WD 54 

 

 5. When using drag and drop, a(n) ____________________ insertion point shows you where selected text will be inserted.  

 

ANS: dotted 

 

PTS: 1 REF: WD 56 

 

 6. The ____________________ is a temporary storage area on your computer that holds text or graphics until you need them.  

 

ANS: Clipboard 

 

PTS: 1 REF: WD 57 

 

 7. To ____________________ means to place a copy of whatever is on the Clipboard into the document.  

 

ANS: paste 

 

PTS: 1 REF: WD 57 

 

 8. The text you type in the Find what text box is known as the ____________________.  

 

ANS: search text 

 

PTS: 1 REF: WD 61 

 

 9. When you ____________________ a document, you make changes that affect the way the document looks.  

 



ANS: format 

 

PTS: 1 REF: WD 64 

 

 10. The term ____________________ refers to the way a paragraph lines up horizontally between the margins. 

 

ANS:  

alignment  

 

PTS: 1 REF: WD 69 

 

 11. By default, text is aligned along the ____________________ margin.  

 

ANS: left 

 

PTS: 1 REF: WD 69 

 

 12. If text appears ragged on the left side, the document is aligned with ____________________. 

 

ANS: right alignment  
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 13. When you ____________________ a paragraph, you move the entire paragraph to the right.  

 

ANS: indent 
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 14. To copy formatting to multiple items, double-click the ____________________ button in the Clipboard group.  

 

ANS: Format Painter 

 

PTS: 1 REF: WD 73 

 

 15. You can emphasize a list of items by adding a heavy dot, or ____________________, before each item in the list. 

 

ANS: bullet 
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 16. Using ____________________, such as bold, underline, or italic can help to emphasize text.  

 

ANS: formatting 
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 17. A(n) ____________________ button allows you to click once to format the selected text, and click again to remove the formatting from the 

selected text. 

 

ANS: toggle 
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 18. A(n) ____________________ is a combination of keys pressed at the same time, instead of clicking a mouse. 

 

ANS: keyboard shortcut 

 

PTS: 1 REF: WD 79 

 

 19. The term ____________________ refers to the shape of the characters in a document.  

 

ANS:  

“font” 

font 
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 20. By default, the ____________________ theme is selected in each new Word document.  

 

ANS: Office 
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ESSAY 

 

 1. Choosing the Ignore All option in Word’s Spelling and Grammar Checker can be a time saving option for some projects. When might using 

Ignore All present potential problems in a document? Define the differences between Ignore All and Ignore Once, and give an example of how 

using Ignore All might be both a benefit and a risk. 

 

ANS:  

Clicking the Ignore All button will tell Word to skip all instances of the highlighted text and continue searching the document for errors. 

Clicking the Ignore Once button tells Word to skip the current highlighted instance, but to continue flagging these errors as it checks the rest of 

the document.   

 

Choosing Ignore All is a good option if you use a company name or a name with a unique spelling several times in a document and do not wish 

to be notified of each instance. However, clicking Ignore All accidentally or for a word that might have other truly incorrect instances may 

result in a final document with errors. 
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 2. Finding and replacing words in Microsoft Word is made easy by utilizing certain tools. When using the Replace All button, what are some 

important things to keep in mind? Give an example of when using Replace All would not be a good option.  

 

ANS:  

When using the Replace All button with single words, keep in mind that the search text might be found within other words. To prevent Word 

from making incorrect substitutions in such cases, it’s a good idea to select the Find whole words only check box, found by clicking More for 

additional options. Without Find whole words checked, if you replaced the word “figure” with “illustration”, Word would replace “figure” in 

“configure” with “illustration” so that the word became “conillustration.”  
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 3. What is the Print Preview option?  How do you access it, and why is it a useful tool when creating documents?  

 

ANS:  



Print Preview allows you to see a document exactly as it will appear when printed. To access the Print Preview screen, click the Office Button, 

point to Print, and then click Print Preview. The document will display in Print Preview. Print Preview allows you a final chance to look over 

your document for errors. You can see the overall layout of the text, catch any alignment or indentation errors, and return to Print Layout view 

to make changes to your document before printing.  
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